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excerpt from chapter fi fteen
3D

multi-pass rendering

After Effects is used for many differ-

ent purposes but the area in which it 

is probably most widely used is in the 

post-production of footage. For those 

of you unfamiliar with the term, this is 

when the produced footage, image and 

animations are put together and any ef-

fects, color treatments or graphics are 

added.

Quite often the compositor will have to 

mix 2D and 3D footage together at this 

stage, making sure that the ‘joins’ between 

these two worlds are seamless. 

You’ll often fi nd, when talking to artists 

and designers that they tend to have a 

preference towards working in either a 2D 

or 3D environment. I’ve often overheard 

individuals complaining that they feel 

‘uncomfortable’ outwith their chosen 

environment,

Being from a fairly traditional 2D back-

ground myself, I have only begun getting 

into 3D animation quite recently, in fact 

my interest really started growing since 

working with some of the 3D concepts 

introduced in After Effects 5. 

One of the things that, in the past, put me off some 3D anima-

tion was the fact that it was too unrealistically ‘real’, too perfect, 

shiny and polished. I prefer work that has more of an edge to 

it, you know, with a slightly ‘grungy’ quality. 

In recent years I’ve seen some really impressive 3D work, which 

displays these qualities. After researching the techniques used 

to produce these works I discovered that the all too important 

fi nishing touches were often added in post-production with 

applications such as After Effects. All the things that make a 

scene more realistic can be added after the 3D render is com-

plete. To make these 3D renders easier to edit and to make 

them more fl exible you can render the image or movie out as 

a multi-pass render. 

Figure a: Here is a frame from a fi nished QuickTime movie that you will 

learn to create using a Cinema 4D multi-pass render, Zaxwerks Invigora-

tor and a smattering of special effects!
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I have recently become interested in learn-

ing more about 3D, in fact I’m currently 

trying to fi nd time to spend with my two 

3D applications of choice: Alias Wavefront 

Maya and Maxon Cinema 4D XL. 

It may seem quite odd to you that I have 

two favorites but up until fairly recently, 

Maya’s price was out of the reach of most 

small production houses. It also has a 

complicated install procedure which 

makes it diffi cult to transport the software 

from one machine to the next and this is 

something that has to be done at times 

when freelancing. Whenever I work away 

from my studio I take my copy of C4D to 

install on the machine where I work (I also 

remove it from the same machine when 

I fi nish the job!!)  Cinema 4D is an excel-

lent, low cost alternative which can pretty 

much match Maya feature for feature. Its 

interface is  very similar to that of Maya 

but also has some unique features which 

we will take a look at in the following 

tutorials.

Tim Clapham, a very talented designer at 

Hypa solutions in Brighton, England, and 

myself, designed these tutorials. Tim con-

centrated more on the Cinema 4D aspects 

whilst I concentrated on the After Effects 

side of things. In a way, this echoes the 

way that many real world studios work: 

one designer passing the 3D materials 

onto the post artist for effects and fi nish-

ing touches.

There are two main sections to this tuto-

rial. The fi rst part showed you how to 

set up a scene in Cinema 4D. This is the 

second main section; it shows you how to 

adjust elements of the 3D scene in After 

Effects.

What is a Multi-pass Render?

These passes are then composited together in a compositing programme 

such as After Effects where they can be adjusted using transformations, 

blending modes and effects. 

We’re going to take a look at a couple of techniques for re-composing 

these Cinema 4D multi-pass renders within After Effects.

A multi-pass renders each element of the scene as a separate pass. For 

example: Below are some of the individual passes that can be rendered 

from Cinema 4D: depth, refl ection, and diffuse values respectively. 
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1 importing       
   multi-pass 

              renders

1 Open After Effects if it is not already 

open.

2 Go to File>New>New Project to open 

up a new Project Window.

3 Double-click on the empty space within 

the Project Window; this will open the 

Import As dialog box. 

4 Go to the Multipass tutorial folder 

and import the fi le named, clubFront_

FINAL.aec.

You’ll notice a short delay as After Effects 

imports the After Effects composition 

which was created in Cinema 4D. Once 

AE has stopped importing you will see 

that two new folders have appeared in the 

Project Window, these folders contain all 

the passes you exported from Cinema 4D. 

(See diagram below)

We’re now going to take a look at how you can import a Cin-

ema 4D multi-pass render along with all associated cameras 

and lights directly into the After Effects Timeline. You’ll learn 

how to adjust elements of the scene in post-production, ani-

mate the lights and even composite new 3D elements within 

the rendered 3D scene.

Later we’ll take a look at how After Effects deals with multi-pass 

renders from other 3D applications. I’ll also show you how to 

extract camera data from 3D rendered RPF sequences (and use 

that data within AE). We’ll also look at some third party fi lters 

that can be useful when working in 3D.

Cinema 4D AE plug-in 
Maxon Cinema 4D has a special After Effects Composition ex-

port feature which allows you to export a multi-pass render 

automatically to the After Effects Timeline. In order to import 

this special fi le, you’ll need a copy of the free CINEMA4DAE 

plug-in for After Effects from Maxon. This is freely download-

able from the Maxon website at: http://www.maxon.de/pages/

download/download_updates_e.html

If you have not already done so, install the CINEMA4DAE plug-

in now and restart After Effects. If you do not have this plug-in 

installed on your system you can skip ahead to the step number 

8 (page 4) where a pre-built project awaits you!

Zaxwerks Invigorator plug-in
Later in this section we’ll be using the Classic version of the  

Zaxwerks Invigorator plug-in for After Effects. This plug-in al-

lows you to create 3D models directly in After Effects. You will 

need this to go through the fi nal parts of this tutorial. A fully 

working demo version is free for download at the following 

website: http://www.zaxwerks.com

Before proceeding remember to check the Readme fi le that is 

included in this download, it contains important information about 

system requirements for the following tutorials.
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5 In the Project Window, open up the 

folder named, CINEMA 4D Composition. 

Within this folder you will see several 

QuickTime movies and a composition, 

also named, CINEMA 4D Composition.

6 Double-click the QuickTime movies 

one-by-one and play them so that you 

can see what the individual passes look 

like. Notice that each pass contains a 

single element from the render, e.g. the 

refl ection pass contains only refl ection 

information. Close the movies once you 

have looked at them. (Fig.1)

7 In the Project Window, double-click on 

the CINEMA 4D composition icon to 

open up its Timeline and Composition 

Window. Notice that all of the layers 

that were rendered out from Cinema 4D 

have been placed into a new Timeline 

in the correct order, with blending 

modes applied. (Fig.2)

8 Go to the File menu>Open Project, open 

up the project named Multipass.aep 

from the Multipass>AE projects folder. 

This is a ready-made replica project full 

of comps which will open even without 

the Cinema4D import plug-in installed.

Figure 1: Multiple passes enable you to be more fl exible with your 3D 

renders. By rendering each element to a separate layer it makes it easier 

to isolate elements in order to make changes in post-production. 

Figure 2: When working with multi-passes from other 3D programs, you have to fi gure out the correct order and blending 

modes for yourself using trail and error. Later I’ll show you how this is done. You’ll also notice that there is a camera and sev-

eral lights within your comp, these have been imported directly from Cinema 4D along with all original settings and animation 

keyframes. This makes it very easy to composite new elements into our 3D scene; we’ll do exactly that a little later.

Inset 1: The Solo switch-

es in the A/V Features 

panel along with the 

Video switches.

If you don’t have a copy of Zaxwerks Invigorator installed, 

or if you are using the Standard version of After Effects 

you will get a message telling you that certain effects are 

not present, if you get a message like this, please click 

OK and continue with the tutorial.
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9 In the Timeline, toggle the Solo 

switches on and off for each layer to 

see the passes and how they interact 

with each other. Do this by clicking in 

the checkboxes under Solo (Inset 1).

10 In the Modes column, notice that the 

correct blending modes are already 

applied to the layers for you. We’ll 

look at this in more detail later

11 Select layer 14, tutorial_light1.mov 

and Toggle its Video switch on 

and off to see its effect on the 

scene. Do the same for the other light 

layers.

These are the light render passes from 

cinema 4D and are just 2D QuickTime 

movies. Notice that as well as these light 

layers, there are real After Effects cameras 

and lights in the composition (Fig.3)

Figure 3: You may have noticed that the After Effects cameras and lights at 

the top of the screen don’t appear to have any effect on the other layers. 

This is because none of the layers are 3D yet so cannot react to the lights 

and cameras. But never fear! I’ll show you how we can use them later.

2                           fl ashing lights 
    and 

   expressions 

1 With layer 14, tutorial_light1.mov still 

selected, hit the T key to bring up the 

Opacity value. (Fig.5)

2 Option/Alt-click on the stopwatch 

to add an expression and then type 

in the following text; wiggle(5,200) 

If you haven’t already completed 

the expressions chapter of the 

Creative After Effects 5.0 book,

I recommend that you do so before continu-

ing with this tutorial; it will give you a good 

basic understanding of expressions. If you 

continue without a good basic understand-

ing you may fi nd the remainder of this sec-

tion quite challenging but please feel free to 

continue if you feel confi dent. If you would 

prefer to skip this section, and come back 

to it later move straight ahead to the next 

section, ‘Colored Lights’ where we will add 

some color animation to the lighting.

Figure 4: We can animate the lightbeams easily in After Effects

The fi rst thing we are going to do to our scene is to animate 

the lights fl ashing on and off. We’ll use the wiggle expres-

sion that we learnt about in Chapter Fourteen of the book, 

‘Expressions’. This time we’ll use a new technique to adjust 

the timing of the resulting values.
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3 Hit  the Enter key on the number pad  or 

click away from the text fi eld to activate 

the expression. This will wiggle the 

value fi ve times every second of the 

animation by a maximum range of 200 

from the original setting (Fig.5).

OK, we used a pretty basic expression to make the lights fl ash 

on and off repeatedly; but we only have one light fl ashing. How 

can we make all of the lights fl ash on and off at roughly the 

same speed? The logical way would be to link the other layers 

to the wiggled layer; this way we could control the speed of 

the fl ashing lights by simply adjusting one single layer. The 

concept is good and so if you came up with this solution, you’re 

on the right track, well done, but, there is a slight problem that 

I’ll now demonstrate to you.

5 In the Timeline, select the tutorial_light2.mov layer and 

then hit the T key to bring up the Opacity property.

6 Alt-click on the Opacity stopwatch to add an expression. 

7 Drag the Pickwhip from the tutorial_light2.mov layer ‘s 

Opacity value to link to the tutorial_light1.mov layer’s 

Opacity value (Fig.6). The expression should now read;

this_comp.layer(“Tutorial_light1.mov”).opacity

As I mentioned in the Expressions chapter it helps to break 

down the expression as you would a fi le path on your com-

puter’s hard drive. This would mean that the Opacity value of 

this layer is now being taken from;

This composition/ Layer, Tutorial_light1.mov/ Opacity value

8 Hit the Enter key and then RAM preview the result. Both 

layers should be fl ashing with exactly the same timing. If 

they are not, you have perhaps missed a step. No problem, 

simply undo your steps in the Edit>Undo menu till you have 

undone the previous ‘Add Expression’, then repeat steps 7 

and 8.

Figure 5: Adding an expression

Never hit the Return key on your 

keyboard to activate an expression 

as this will add a carriage return to 

the expression. If you have accidentally done 

this, don’t worry! Either hit the Enter key on 

your keyboard’s number pad or click anywhere 

in the gray space outside the expression text 

fi eld to activate your expression.

4 RAM preview the animation to see the 

light fl ashing on and off.

I have only selected to render one pass 

for each light in this instance but you can 

choose to render up to three separate 

passes for each light, diffuse, specular 

and shadow. If you had rendered all three 

passes, they would be nested together in 

pre-comps where you could adjust the 

passes individually. In this case, to save 

on disk space we are only working with 

the light beams themselves.
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Notice that both layers are fl ashing with 

exactly the same timing; this is not the 

effect we want. We want the layers to be 

fl ashing at the same speed but it would be 

preferable if the lights fl ashed randomly. 

There are several ways of achieving this 

but the easiest way is to simply offset the 

timing a little. We can do this easily by us-

ing the Value at Time expression.

The Value at Time expression is useful if 

you want to offset the timing of an anima-

tion, whether it is a keyframed animation 

or the result of an expression. To offset 

the timing of a keyframed animation the 

Value at Time expression would be added 

directly after the property. For example, 

adding to the opacity expression so that 

it reads; 

opacity.value_at_time(time+1)

would move the whole animation forward 

by one second.

In this case, we want to offset the result we 

have obtained by pickwhipping to another 

layer. This makes this expression slightly 

more complicated, but you can still cope 

with it I’m sure! The expression should 

currently read;

Figure 6: Dragging the Pickwhip to link Opacity values between layers

this_comp.layer(“Tutorial_light1.mov”).opacity 

9 To offset the animation by one second simply place the 

cursor at the end of the expression text and add to it so 

that it fi nally reads;

this_comp.layer(“Tutorial_light1.mov”).opacity.value_at_time(time+1)

This just takes the result of the original expression and offsets 

in time by one second, moving it forward. 

variables
As I mentioned in the Expressions chapter of Creative After 

Effects 5.0, it’s good to break expressions down into sections 

so that they are easier to understand. One way of doing this 

is to use variables. You can achieve exactly the same result as 

the previous example by using the following expression which I 

think is much more elegant:

time expressions

10 Select the tutorial_light3.mov and add an expression to 

its Opacity value.

11 Type in the following expression;

a=this_comp.layer(“Tutorial_light1.mov”).opacity;

a.value_at_time(time+1)

In the fi rst line we set up the letter ‘a’ as our variable. The 

second line is the actual expression, using the variable ‘a’ in 

place of: this_comp.layer(“tutorial_light1.mov”).opacity
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OK, so we have exactly the same expression, just in a different 

format. The only problem is that the last two layers will have 

the same values (Fig.7). 

12 Check this by clicking on the expression graph buttons 

for the last two layers; they will be identical. Make doubly sure 

by RAM previewing the comp. Notice that lights 2 and 3 are 

fl ashing with exactly the same timing, not what we are after!

What we need is for each layer to be offset 

by a different number. When you use the 

index attribute in an expression it returns 

a value based on the layer’s number in the 

Timeline. So, if my layer is number 14, it 

will return a value of 14.

13 Change the expression on the tutorial_

light2.mov layer so that it reads;

a=this_comp.layer

(“Tutorial_light1.mov”).opacity;

a.value_at_time(time+index)

14 Add the same expression to each of 

the other tutorial_light layers’ Opacity 

values. By using the layer’s number 

as the offset value we can offset each 

layer’s Opacity value by a different 

amount.

 

There’s no need to save your project as 

the steps have been saved into pre-built 

compositions for you. However, if you re-

ally want to you can save your project into 

a new folder on your hard drive.Figure 7: Both expressions return exactly the same values.

3Colored lights
Now we have all the lights flashing 

we’ll use a pre-saved favorite effect to 

apply a color effect to all the light layers.

1 In the Project Window double-click 

the 02_Colored Lights composition to 

open its Comp Window and Timeline. 

This contains a composition that is 

almost identical to the one you have 

been working on.

2 Select tutorial_light1.mov in the 

Timeline window and go to Effect>Apply 

Favorite.

3 Navigate to the Multipass>Favorite FX  

folder; choose the Wiggle_Hue.ffx 

favorite effect to apply to your footage.
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This is a Favorite Effect, which I saved 

earlier. As well as being able to save the 

actual affect and it settings, Favorite Ef-

fects also save any keyframe or expression 

information associated with the effects. 

This particular Favorite Effect has the 

Hue/Saturation effect applied, which has 

a wiggle expression attached to it. 

4 RAM preview the comp to see the Hue 

value of light 1 animating over time.

5 Select the tutorial_light1.mov in the 

Timeline and then double-hit the ‘E’ key 

to open up any expressions applied to 

the layer. 

Notice that this Hue property has a wiggle 

expression, similar to the one used to wig-

gle the lights opacity in the previous sec-

tion. The saturation of the lighting color is 

a little bit too high at the moment, making 

the light a very bright, unreal color.

6 Open the Effect Control Palette if it is 

not already open.

 (Command/Control+Shift+T)

7 Go to the bottom of the Effect Control 

Palette to fi nd the Colorize Saturation 

value, change this value to 60 to reduce 

the saturation of the light color (Fig. 8) 

Another new feature of After Effects 5.5 is 

the Effects Palette, which is a completely 

separate entity from the Effect Controls 

Palette. You can fi nd the Effects Palette 

in the same group as the Time Controls 

Palette and the Audio Palette.

8 Click on the Effects Palette tab in the 

palette group, or, if it is not currently 

visible, go to Window>Effects to open 

it up (Fig.9)

Figure 8: the Hue/Sauration Effect Control Palette

Figure 9: After Effects 5.5’s new Effects Palette
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9 In the Effects Palette, click on the wing menu to reveal 

the choices available to you. Toggle between the first 

three options in the menu (Category; Finder Folders or 

Alphabetical) to see how the effects are listed using the 

different methods. Finish with them displayed in their Finder 

Folders. (NB: If you only have one folder within your plug-in 

folder, you will not see any folders, only the effects as they 

are listed alphabetically).

Another way of making the light a little bit more realistic is to 

add a bit of noise to break it up a little. In the Effects Palette, 

you will see a Contains text box at the top of the palette; this 

allows you to search quickly for effects by their name.

10 In the Contains text box, type the word noise. All effects 

containing the word noise should now appear in the folders 

that are contained within the fi nder. Effects can be dragged 

and dropped from the Effects Palette directly onto layers 

in the Timeline; the Effect Controls Palette or the Comp 

Window, a very fl exible way of working.

The next two steps can be followed in two different ways 

depending on which version of After Effects you are using. 

Please follow PB if you are running the Production Bundle 

or SV if you are running the Standard Version.

11 (PB) If you have the Production Bundle of 

After Effects, you will see the Fractal Noise fi lter 

listed. If so, click and drag this effect from the 

Effects Palette onto your tutorial_light1.mov 

in the Timeline. 

12 (PB) In the Effect Controls Palette change the Contrast to 

125% and the Transfer Mode menu to Multiply. This will give 

your light a smoky effect. (Fig. 11)

11  (SV) If you have the 

standard version of After 

Effects, the Fractal Noise 

effect will not appear in the 

list. If this is the case, drag the Noise 

effect onto your tutorial_light1.mov 

layer in the Timeline.

12 (SV) Change the Amount of noise value 

to 2%. This will give you a different 

result from the Fractal noise filter, 

more like the light being shone through 

particles of dust. (Fig. 12)

Before we preview the effect we’ll use 

the same effect on all the other light lay-

ers.  You can continue with the next step 

whichever version of After Effects you 

are using.

13 Another really nice new feature of the 

Effects Palette is the ability to save 

favorite effects by dragging them onto 

it. Before continuing with the next step, 

make sure that you can see both the 

Effect Controls Palette and the Effects 

Palette, side by side (Fig. 10).

The Effects Palette has several uses, the most important be-

ing an effects management system. In here you can choose 

to view all available effects in several new ways: 

By Category – as they normally appear in the Effect menu);  

In Finder Folders – as they appear on the hard disk (useful for viewing 

effects in package groups); or as an Alphabetical List.

In Finder Folders – as they appear on the hard disk (useful for viewing 

Figure 10: Drag multiple effects to save as favorites
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14 In the Effect Controls Palette, select both of the effects 

and then drag them onto the Effects Palette (Fig. 10).

15 You will then be given the opportunity to save these. 

Navigate to the desktop to save your new favorite effect.

 

19 All the selected layers will now have 

the favorite effects and expressions 

added to them. RAM preview to see 

the results.

In the Project Window you will see two 

comps named, 03[PB]_Reflection and 

03[SV]_Refl ection. These are pre-saved 

versions of the comps you have just fi n-

ished working on. In the PB version I have 

taken the extra step of animating the Evo-

lution property of the Fractal Noise effect. 

In the Standard Version I have removed 

the effects from Tutorial_light4.mov to 

make the effect more subtle.

20 RAM preview the appropriate comps 

to see the effect. Remember that you 

will not be able to see the animating 

fractal noise if you are working in the 

Standard version ( Figs. 11 & 12). 

These are just two very simple examples 

of how you can change the property of 

your light in post-production. In this 

example you may have noticed that only 

some of the lights are refl ecting onto the 

fl oor. To save disk space we have only ren-

dered out a single pass for each light. You 

can have a much higher level of control by 

rendering out individual passes for each 

property of the light. In this way you can 

control the light beam, the light refl ection 

and its diffuse qualities separately. 

Figure 10: Drag multiple effects to save as favorites

16 If you are 

working in 

the Produc-

tion Bundle,  

name your new favorite ef-

fect Fractal_noise_Hue.ffx 

and save it to the desktop.

17  Deselect the tuto-

rial_light1.mov layer and 

then select all the other 

tutorial_light layers.

18  Go to the Effect 

menu>Recent Favorites and 

apply your new favorite Ef-

fect, Fractal_noise_Hue, to 

all the selected layers.

16 If you are 

working in 

the Standard 

version, name 

your new Favorite Effect 

Noise_Hue.ffx and save it 

to the desktop.

17  Deselect the tuto-

rial_light1.mov layer and 

then select all of the other 

tutorial_light layers. 

18 Go to the Effect 

menu>Recent Favorites 

and then apply your new 

Noise_hue effect to all of 

the selected layers.

Figure 11: The Production Bundle’s Fractal Noise effect applied

Figure 12: The Standard version’s Noise effect applied

You could try the same technique 

substituting the Hue/Saturation 

effect with one of my favorites, 

Colorama. This way you could try 

a multitude of color combinations very quickly 

and easily. But remember that Colorama is not 

(at the time of writing) a 16-bit effect. Hopefully 

it will be by the time you read this!



12 chapter fi fteen: 3D

Creative After Effects 5.5  © 2002 Angie Taylor. All Right Reserved      http://www.angie.abel.co.uk/book.html

 chapter fi fteen: 3D 13

Creative After Effects 5.5  © 2002 Angie Taylor. All Right Reserved      http://www.angie.abel.co.uk/book.html

4refl ection
  defl ection 5matching 

camera     
   moves
Up until now, we’ve adjusted our scene 

by applying effects and expressions to 

existing elements but what if we wanted 

to introduce a new element into the 

scene? You would think that this would 

be impossible; surely once the scene has 

been rendered it would be too late to 

introduce new elements?

With the Cinema 4D import you can, be-

cause as well as exporting all of the passes 

as 2D QuickTime movies, Cinema 4D ex-

ports all of the lights and cameras used 

in your scene, along with any keyframes 

associated with them, making it very easy 

to match up camera moves.

1 Open the 04_Composite comp by 

double-clicking it in the Project 

Window. Notice that there is a new 

layer, 60Dance.mov which is bigger 

than the composition and currently 

obscuring the other layers (Fig.14). 

2 RAM preview to see the dancer dance.

That’s how easy it is to reduce the amount of refl ection in post 

when working on a multi-pass render! We could also use blurs 

and/or displacement maps to alter the perceived texture of the 

surface; here we’ll use a simple blur effect.

4 In the Effects Palette (Window>Effects) type in the word 

blur to isolate all the available blur effects.

5 Drag and drop the Directional Blur effect onto the tutorial_

refl .mov layer in the Timeline. This allows us to alter the 

angle of the blur to fi t in with the angle of the fl oor.

6 Change the blur Length value to about 3 and the blur 

Direction value to –118 degrees so that it is blurring in the 

same direction as the fl oor tiles.

Figure 13: Hot text

Figure 14: Boogie woogie!

OK, so imagine that the producer looks at the render and 

says, “I love it! But there’s too much refl ection on the ground; 

it just looks too shiny”. Well, with a regular 3D render we 

would have to go back to the 3D program, adjust the settings 

and render again. Not so with a multi-pass render, it’s very 

easy to adjust the amount of refl ection. There are several 

ways of doing this, and I’m going to show you the quickest 

and easiest way to do it.

1 Open the 03b_Refl ection SV comp by double-clicking its 

icon in the Project Window. We’ll continue to work on this 

project as it will work correctly on both versions of AE.

2 Select the tutorial_refl .mov layer and then hit the ‘T’ key to 

open up its Opacity property.

3 Move your cursor over the Opacity value (which currently 

reads 100%) till it changes to a hand with a fi nger pointing. 

You can now scrub the Opacity value to the left till it reads 

60%. You will see the opacity of the layer change in the 

Comp Window as you scrub (Fig.13). 
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We are going to composite this footage 

into the window areas at either side of 

the door in our scene so that it appears 

to be a silhouette of a dancer inside the 

nightclub. This layer is very obviously a 

2D layer – like all the other QuickTime 

movie layers within this composition. 

You may be a little confused at this point. 

Because the multiple passes were import-

ed along with real After Effects cameras 

and lights you may be thinking this scene 

is three dimensional but remember that 

the passes are all 2D QuickTime movies 

composited together. It’s important to 

understand that at this point.

3 Switch off the Video Switch for the 

60Dance.mov in the Timeline.

4 Select the tutorial_diffuse.mov layer 

in the Timeline and then, in the Comp 

Window, drag it around the screen to 

see what happens. The layer will move 

around the screen demonstrating clearly 

that it is a 2D layer. 

5 Hit Command/Control + Z to undo the     

last step.

6 Switch the Video Switch back on for the 

60Dance.mov layer.

7 Switch on the 3D Switch for the 

60Dance.mov layer and notice 

that it appears to shrink as it jumps 

into the 3D scene (Figs. 15 & 16).

The layer has not really shrunk, it is simply 

reacting to the camera that was imported 

from Cinema 4D, which happens to have 

different coordinates than the default 

After Effects camera. 

Figure 15: Click inside the little check-

box under the 3D switch to make your 

layer 3D and watch it react to the After 

effects cameras and lights.

Figure 15: Click inside the little check-

box under the 3D switch to make your 

layer 3D and watch it react to the After 

Figure 16: The layer jumps into 3D space

If you want your animation to begin with the same point 

of view as the default After Effects camera (so that your 

layer will be seen at its original size within the comp) you 

should create a new camera in AE with the default 50mm 

settings. Then, take down a note of all the coordinates, then 

transfer them to Cinema 4D camera to achieve the correct starting posi-

tion. Remember that we also used nulls to control the camera in Cinema 

4D so their coordinates also have to be taken into consideration. 

Notice that the two Camera layer’s values are very different 

from each other, hence the difference in views between 

them. Remember that the layer has not really shrunk, it is 

only the camera from C4D that makes it appearthat way. 

It’s important to keep this in mind when planning your comps. 

You want to avoid stretching your layers, particularly when working with 

bitmap images or movies.

It’s important to keep this in mind when planning your comps. 

 If you are creating a new image that you wish to fi ll the 

screen, set up a test composition with the camera as you 

want it. Place a 3D layer in the desired position and then 

stretch it to its required size. Take a note of the pixel 

measurements, and use this information to format the new fi le at the 

required resolution before importing into After Effects.

measurements, and use this information to format the new fi le at the 
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8 Go to Layer>New>Camera to bring up the Camera Settings 

box (Fig.17).

9 Name the camera ‘Test Camera’, choose 50mm in the Preset 

menu and then click OK. As you do this, the 60Dance.mov 

layer will appear to jump back to its default position. This 

demonstrates that the default After Effects camera’s 3D view 

will match up with the comp’s 2D appearance. Just as with 

regular layers, the view of the camera layer highest in the 

Timeline will override any other camera views below it. 

10 Select both camera layers and hit 

the ‘P’ key to open up their Position 

properties. Notice the difference 

between the two camera’s coordinates, 

resulting in different views for each.

11 Select only the ‘Test camera’ and then 

hit Backspace to delete it. Close up any 

open layers.

12 RAM preview the composition. Notice 

that the new layer now reacts to the 

After Effects cameras and lights making 

the layer appear to be positioned in the 

original 3D scene.

Because these cameras and lights match up 

exactly with the cameras and lights used in 

the Cinema 4D render, it appears as though 

the layer is now within the 3D scene. This is 

an optical illusion but it works very well!

If you have an existing fi le that you will be zooming into, or if 

you need a layer to appear bigger than it’s default size, make 

sure that you resize it to the maximum size required in the 

application where it originated before importing it into 

After Effects. If this is not possible you can plan the whole 3D scene 

around the size of the original footage by placing a copy of the image 

you want to work with into your 3D application as a guide.

If you have an existing fi le that you will be zooming into, or if 

you need a layer to appear bigger than it’s default size, make 

sure that you resize it to the maximum size required in the 

application where it originated before importing it into 

Figure 17: The Camera Settings dialog box
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The one thing that it is not yet supported 

in the Cinema 4D export is  nulls. I’m not 

exactly sure why this is; both applications 

support nulls so why can’t the twain meet? 

The honest answer is that I don’t know, 

you would have to ask the programmers. I 

have a suspicion that it must be something 

to do with the way the coordinates of nulls 

are measured in the two applications. Af-

ter Effects places the anchor point of a null 

on the top left corner of the layer whereas 

Cinema 4D nulls are measured from the 

centre point of their 3D world. 

It really would be great if nulls were also 

exported, and if their parenting relation-

ships could also be maintained. That way, 

we could use nulls to easily match up the 

coordinates between the two applica-

tions. Meanwhile, I can tell you how to 

get around this oversight by using dummy 

lights as nulls.

If you followed the Cinema 4D tutorials 

you may remember that there were some 

extra lights in our scene, which were 

switched off. Those lights were placed 

into the scene for one reason only; to 

give us coordinates to copy to our new 

elements in After Effects. If you know in 

advance that you will be compositing new 

elements into a scene, simply place lights 

(with no properties) in the position that 

you want the new element to appear. I’ll 

show you how you can use this informa-

tion in After Effects.

13 Move to the three–second mark.

14 Select the Right of door light layer and 

hit the ‘P’ key to open up its Position 

property.

15 Click on the word Position in the Timeline to make this 

property active and then hit Command/Control–C to copy 

the position value.

16 Select the 60Dance.mov and then hit command/Control–V 

to paste the position values into the layer. The dancer 

should now jump to the same position as the light layer. 

(Fig.18)

17 Select the right of door light layer and hit backspace to 

delete it.

OK, so we have one dancer roughly in position but she’s white 

on black, we want a black silhouette on a white background. 

It’s very easy to reverse this image by using one of the Chan-

nel effects.

18 In the Effects Palette, type in the word Invert to isolate any 

effects containing this text.

19 Drag and drop the Invert effect onto the 60Dance.mov 

layer in the Comp Window. This effect will invert the color 

channels, making our dancer black on white. You can 

clearly see the lights now reacting with the layer’s white 

background.

20 In the Comp Window, scale the 60Dance.mov  layer down 

to 85%. 

Figure 18: Using the light layer as a null

Remember to use the Info palette as a guide to tell you how 

much you are scaling by. The Info palette is also extremely 

useful for displaying position coordinates and color values 

(Window>Info [Command/Control+2]).
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21 To make the background disappear, in the Modes panel of 

the Timeline, change the blending mode of the dancer layer 

to Multiply. 

Notice that there is still a slight edge left where the lights were 

shining onto our layer. To get rid of this we’ll use a mask as a 

garbage matte. A garbage matte is a hand drawn matte which 

gets rid of unwanted areas of your image. The easiest way 

to do this in After Effects is to use masks. As a rule I tend to 

prefer to draw my masks in the Layer window as I can see my 

layer in its original state without effects applied (See Masks 

chapter) but in this instance  the ability to draw masks directly 

into the Composition Window really comes in useful as I can 

see the layer in its fi nal position and use the background as a 

guide for my mask.

22 Click the Title bar of the Comp Window to make sure that 

it’s active and then change the magnifi cation to 200% by 

hitting the Period key on the keyboard (the Comma key 

will scale down).

23 Hold down the spacebar to change temporarily  to the hand 

tool; with this drag inside the Comp Window to move the 

image within the frame so that you can see the dancer and 

the panel behind her

24 Select the Rectangular marquee tool from the Tool 

Palette and draw a mask around the edges of the 

panel, don’t worry if you are masking off part of the 

dancer’s arm, we can fi x this later (Fig.19).

The Pan Behind tool has several uses, as 

we learnt in previous chapters. It can be 

used to move the anchor point of a layer 

without affecting the layer’s placement in 

the Comp Window. It can also be used to 

move (or pan) a layer behind its mask; do-

ing this will adjust the Position and Mask 

shape values in one easy action.

25 Select the Pan Behind tool (Y) 

from the Tool Palette.

26 Click on the 60Dance.mov 

layer in the Comp Window (avoid the 

anchor point of the layer as this will 

move the anchor point instead) and 

drag the layer to the right till her arm is 

lying just inside the mask boundaries.

27 Reselect the Selection tool by 

hitting the ‘V’ key. We’ll now 

create a second dancer to go 

in the opposite panel.

28 With the 60Dance.mov layer still 

selected, hit Command/Control+D to 

duplicate it.

Figure 19: Using a mask to create a grabage matte

If your layer does not appear 

to have duplicated it could be 

that you still had the mask se-

lected when you hit Command/

Control+D. A new feature of After Effects 5 was 

the ability to duplicate masks. This is one of the 

rare cases where I don’t particularly like a new 

feature, it’s too easy to accidentally duplicate a 

mask instead of a layer which can cause confu-

sion. If this has happened to you, select your 

layer and hit the ‘M’ key to open up any masks 

applied to the layer. If you have more than one 

mask, delete all but one of them and then make 

sure that the remaining mask is not selected 

before hitting Command/Control+D again to 

duplicate the layer. Watch out for this one, it’s 

caught me out on several occasions.

If your layer does not appear 

to have duplicated it could be 

that you still had the mask se-

lected when you hit Command/
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29 Copy and Paste the Position value from the Left of door 

light layer into the new 60Dance.mov layer as you did in 

steps number 14–17. 

30 Remember to delete the Left of door light layer when you 

are fi nished with it.

31 Nudge the new layer into place if need be, using the arrow 

keys on your keyboard.

32 To make the dancer move in the opposite direction to the 

fi rst dancer, hit the ‘S’ key to open up the Scale property 

and then click on the Aspect Ratio Unlock key (Fig.20) to 

the left of the three scale values. 

This feature enables you to adjust each 

value independently without constrain-

ing the aspect ratio, a very welcome new 

feature to version 5.5.

33 Reverse the Scale on the X-axis only, 

making it –85% (Fig.20).

34 RAM preview the comp so far. In the 

fi nished movie I’ve also added a blur to 

the dancers to make them look more 

shadowy.

6zaxwerks 
    invigorator

If you want to skip this part of the tutorial-

and cover it later, when you have installed 

the Invigorator software, please go to the 

next section, Adjusting Depth of Field.

Figure 20: The Aspect Ratio Unlock keys

If you bought the complete After Effects 5.5 Production Bundle 

you will have received a free copy of Zaxwerks Invigorator 

Classic with the package (this was not included in the upgrade 

package). If you didn’t receive Invigorator as part of the package, 

you may want to consider investing in it as it really is worth the 

investment, as you will see. Invigorator is a plug-in which allows 

you to create true 3D objects within After Effects. The plug-in 

comes in two ‘fl avors’: the Classic version which allows you to 

extrude your vector artwork into 3D objects (amongst other 

things which we’ll take a look at later); and the Pro version which 

offers a whole lot more including the ability to import 3D objects 

from other applications. We’ll take a look at some features of 

the classic version today but if you want to fi nd out more (or if 

you want to download the demo version to continue with this 

tutorial) please visit the website at; http://www.zaxwerks.com
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We’re now going to make a sign from a 

logo to sit over the doorway of the night-

club. The nice thing about this is that 

we can make changes to the sign in post 

production, so, for example if the client 

decided to add a subtitle, it could be easily 

changed without having to re-render the 

whole lot in a 3D program. In the following 

exercise we will take a look at some of the 

features of Invigorator but there’s a whole 

lot more to this plug-in than we’ll have 

time to look at here so please do explore 

it more for yourself afterwards, it comes 

with an excellent manual as well as a great 

QuickTime Introduction movie.

1 Open 05_Invigorator comp from the 

Project Window.

2 Hit Command/Control+Y or go to Layer 

menu>New>Solid to open up the Solid 

Settings box. In order to use Invigorator 

you fi rstly need to create a layer to 

apply the plug-in to.

3 Name the new layer ‘Logo’, click the 

Make Comp Size button to make the 

layer the same size as the composition 

and then click OK.

4 With the layer selected, go to Effect>

Zaxwerks>Invigorator (or use the 

Effects Palette to drag and drop the 

effect onto your layer.

5 If you are using Invigorator Classic, the 

Select Artwork box will appear where 

you can locate the tott.ai file from 

within the Multipass>Footage folder, 

click once to select it (Fig.21).

6 If you are using Invigorator Pro, a 

dialog box will appear giving you a 

choice of four options, choose Create 

a shape Object. This will take you to the 

same select Artwork box where you can 

click once on the tott.ai fi le to select it.

7 At the bottom of this box, check the Use Illustrator Colors 

box; this way the colors you chose in Illustrator for your 

logo will be matched exactly in Invigorator, very handy for 

matching up corporate color schemes.

8 Make sure the Move Object to Center button is checked 

and then hit the Select button. Your logo will be taken into 

Invigorator and extruded to make a 3D object. (Fig.22)

9 You may need to rearrange your windows before continuing. 

Make sure that the Effect Control Palette is big enough so 

that you can see all of the Invigorator controls easily. 

Also make sure that both the Effect Controls Palette and 

the Comp Window are situated so that you can see both 

simultaneously.

10 Once you are happy with the screen layout go to Window 

menu>Workspace>Save Workspace. In the Choose Name 

box, type in ‘Invigorator’. This window layout will be saved 

so that you can easily change it back at any time. 

Figure 21: The Invigorator Select Artwork box

At the bottom of this box, check the Use Illustrator Colors 

Figure 21: The Invigorator Select Artwork box
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11 Back in the Effect Controls Palette, 

click on the button with the red 

sphere on it, to the right of the palette; 

this is the Set-Up Window button. As 

you click, a new Set-Up window will 

open up; this is where you can change 

the non-animatable properties of 

your objects such as shape, bevel, 

color, textures and rendering options 

(Fig.23).

NOTE! You can also access the same setup 

area by clicking on the word Options at 

the top of the Effect Controls Palette.

12 Notice that there is a toolbar with 

several square buttons underneath the 

Scene Preview window. The buttons on 

the left are the Mode buttons; these are 

for switching between Camera, Light or 

Object mode. At the moment we are in 

Camera Mode so any changes we make 

using the Manipulator buttons on the 

right will affect the camera.

13 Using the Camera 

Tumble tool, adjust 

your view any way you 

want by clicking and 

dragging within the Scene 

Preview window.

14 On the Left of the 

palette you will see the 

Views drop-down menu; 

change the view to Front. 

Your view will change so 

that you are seeing your 

object from the front. 

Figure 22: The Invigorator window and the Setup window buttonFigure 22: The Invigorator window and the Setup window button

Figure 23: The Invigorator Setup window
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This is a fi xed view, and, although the 

view can be adjusted by using the camera 

manipulation tools, you can quickly reset 

your view by selecting the presets in this 

menu. You can also save any of your own 

custom views as presets in this menu.

15 Click on the Object Mode button 

to enter Object mode. Look 

underneath the Toolbar, and to the 

right slightly; you will see a menu that 

currently reads ‘None Selected’. Click 

on this menu and choose ‘Select All’ to 

make sure that all objects which make 

up the group are selected. 16 Look to the right hand pane of the Set-Up window and 

notice that there are three tabs; we currently have the 

Object tab open. In here you can do various things to adjust 

the appearance of your object. Let’s take a look at the Bevel 

options (right hand panel of Fig.24).

The logo that we are using is quite a complex one but 

you can create your own perfectly round neon tube 

much more easily using Illustrator and Invigorator Clas-

sic, here’s how. Draw the neon sign text in Illustrator 

as a single, open path shape (try using your name for this). Give the 

tube path a stroke weight and then use the Outline Stroke command to 

give yourself a path that is now a fi lled object. Save this as ‘Neon.ai’. 

In After Effects apply Invigorator to a layer and choose the ‘Neon.ai’ 

Illustrator fi le. Use the Half Pipe edge profi le on this two-sided path to 

get a perfectly round tube!  One of the cool things about doing it this 

way is that the diameter of the tube can be changed on the fl y by simply 

changing the Depth of the tube object.

as a single, open path shape (try using your name for this). Give the 

Figure 24: The Material Setup window
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17 In the Edges section you will see a 

drop-down menu that currently reads, 

Bevel, Medium. Click on this menu and 

choose Pipes and Half Pipes>Half Pipe, 

Double from the list. Now that you have 

chosen a bevel, you can cycle through 

the remaining choices. 

18 Use the Up and Down arrow keys on 

your keyboard to preview some of the 

other shapes you can choose for your 

bevel. When you’ve fi nished looking, 

choose Pipes and Half Pipes>Half Pipe. 

This will give our extruded shape a 

rounded edge. Although this is not a 

perfectly round edge, we can work on 

it some more to round it off.

19  Notice that the holes inside the letter 

forms have disappeared because of the 

deep bevel. To bring them back, start 

by changing the Edge Scale slider to 

75.

20 Beneath this slider you will see the 

Hole Edges section. This enables 

you to specify a different bevel value 

for the holes in your letter forms. 

Uncheck the Use Same Profi le for Hole 

Edges checkbox and choose Pipes and 

Half Pipes > Half Pipe, Small from the 

menu.

21 Click on the Use Same Scale for Hole 

Edges box to uncheck it and then 

change the Edge Scale value to 35. 

Now you should really be able to see 

the holes properly.

22 At the top-left of the Set-up window 

you will see two radio buttons, one is 

the Scene Preview button, the other is 

the Material Set-Up button. Click on the 

Material Set-Up button (Fig.24). 

This is where you can customize the colors used on the sur-

faces of your objects. At the top left of the window you will 

see a cross-section of your object, showing you the different 

bevels on the inside and outside. Underneath this diagram 

you will see the Materials Palette, this contains all of the 

materials that are currently used in your object. Because 

we chose to keep the colors that we used in Illustrator, we 

have two surfaces, orange for the fi ll color, and black for the 

outline color. Notice that each color has a number and that 

corresponding green number chips are labeling the facets of 

the cross section above.

23 In the right hand pane, click on the Materials tab to see a 

selection of available preset materials that you can apply 

to your objects. We will customize the surface of our object 

with new materials (Fig.25).

Figure 25: The Materials tab
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24 Click and drag the blue material from 

the Materials swatch library onto the 

black material dock to replace it. You’ll 

be asked if you want to save the black 

material; choose No (Fig.25).

25 Drag the yellow material into dock 

number three (Fig.26).

Notice that the cross-section diagram has 

little green material chips next to each 

split section; you can actually add more 

splits to subdivide your sections using the 

Split tool but for now we’ll just work on 

the existing sections.

26 Click and drag the orange material from dock number one 

onto the green material chip next to the front section (Fig.25). 

The section will highlight in red. At this point release the 

mouse button to apply the new material to that section. 

Repeat this process to apply the orange material to the 

Back section, the yellow material to the Outside and the 

blue material to the Holes (As in Figure 26).

27 Click on the Scene Preview button to see the result of your 

customization. OK, so you’ve had a little taster of how to 

customize surfaces. To make our sign look similar to a neon 

sign we only want a glassy surface over the entire object .

28 In the Materials tab Swatch library, scroll down till you 

see the Blue Glass swatch, double-click it to make it active. 

Notice its name and settings appear in the section below 

(Fig.27).

Figure 26: Dragging the Materials onto the docks
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29 Go to the Material Command menu below and select 

Duplicate Material.

30 Change the name of the material to Yellow Glass and then 

click on the Color Swatch to select a bright yellow color 

from the system Color Picker.

31 Change transparency value to 50, this will make it appear 

to be a more opaque glass, similar to the sort of colored 

glass used for neon signs. Change the Refl ectivity value to 

10. 

32 Drag the new material from the preview swatch at the 

bottom of the window into one of the empty swatches in 

the Swatch library at the top of the window. This will save 

it as a new preset swatch (Fig.28).

33 Duplicate this material again and then adjust the color so 

that it is a dark red color. Name it Red Glass and drag it into 

the swatch library.

Figure 27: Dragging the Materials onto the material chips

Figure 28: Saving Material presets
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34 Go back to the Material Set-Up window and replace the 

Dock number one color with the Yellow glass (don’t save any 

of the materials if asked). Replace docks two and three with 

the Red glass. If asked if you want to replace the material 

for all selected objects choose Yes.

35 Click OK to return to the main After Effects interface to see 

your object complete with its new surfaces.

You may have noticed that the material looks nothing like glass 

at the moment. That’s because Invigorator uses Open GL to 

render your image in draft mode. Until it is rendered in Best 

quality mode it will have no anti-aliasing, and no transparency, 

shadows or refl ections etc.

36 Switch your layer on to Best quality to see its glass-like 

qualities (Fig.29).

39 RAM preview the animation. Notice 

that the Logo layer is not reacting to 

the After Effects camera and lights. 

This is because, although this layer 

contains a 3D object, it is still a 2D 

layer within this composition.

The Invigorator plug-in has its own camera 

and lighting system that you can use to 

animate the object within the Invigorator 

world. Invigorator also has an option for 

using the After Effects cameras and lights 

which makes it easier to composite the 

new elements alongside existing 3D anima-

tions and camera moves.

40 In the Effect Controls Palette, check the 

Use Comp Camera and Use Comp lights 

buttons. As soon as you do this you will 

see the Invigorator logo appear to jump 

into 3D space in the same way as the 

dancer did in the Composite section. 

It also begins to react nicely with the 

composition lighting.

The logo has been designed to sit above 

the doorway of the nightclub.Now, you 

may think that you can simply copy and 

paste the coordinates from the Logo 

above Door layer’s Position property to 

the Invigorator layer’s Position property. 

In theory this sounds fi ne but the trouble 

is that the Invigorator layer is still a 2D 

layer; it just contains a 3D object.

In order to change the coordinates of 

the object within Invigorator you need to 

adjust the Sets values that lie within the 

Invigorator effect controls. But because 

we can’t copy and paste values between 

different properties (i.e. between Position 

property and effect properties), we’ll use 

expressions to link the values together.

NOTE!! You may have to wait a little while whilst 

Invigorator calculates all the shadows, transparency 

and refl ections of the glass however, keep in mind that 

a glass surface will be one of the slowest surfaces to 

render, plain colored surfaces will render much quicker than this. render, plain colored surfaces will render much quicker than this. 

37 Once you have seen the glass qualities of your object, 

switch back to Draft Quality to speed up your workfl ow 

before proceeding.

38 In the Effect Controls Palette, change the Views menu to 

Front and notice that the image in the Comp Window updates 

to echo the changes made in the Effect Controls Palette.

Figure 29: Best quality render
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41 In the Timeline, select the Logo above 

door light layer and hit the P key to 

open up its Position property.

42 Select the Invigorator Logo layer 

and hit the E key to open up its effect 

controls in the Timeline.

43 Click on the disclosure triangles next 

to 3D Invigorator, Sets and Set 1 till 

you can see the X, Y, and Z position 

coordinates for Set 1 (Fig.30).

44 Option/Alt-click on the stopwatches 

for Set 1 X Position; Set 1 Y Position 

and Set 1 Z Position.

45 One by one, drag from the expression Pickwhips to the 

corresponding values in the Position property of the Logo 

above door light layer (i.e. from Set 1 X Position to Logo 

above door light layer’s X position). Hit the Enter key on 

the number pad to activate the expressions.

Just when you thought it was safe to go back into the Effect 

Controls Palette, another nasty shock emerges, the layer does 

not jump to the expected position above the doorway, there 

is a slight problem matching up coordinates between After 

Effects and Invigorator. This problem stems from the fact that 

After Effects has a unique way of measuring 3D coordinates.

Figure 30: Linking values using the Expression Pickwhip
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 Most 3D applications (including Invigo-

rator and Cinema 4D) use a Cartesian 

coordinate system which has an X and Y 

axis that meets at the origin or (0,0) point.  

Coordinates are measured from the center 

of the screen (i.e. 0,0 is the center coordi-

nate).  Positive X starts at the origin and 

goes to the right.  Positive Y starts at the 

origin and goes up (Fig.31).  

After Effects is different, the top left corner 

of the Comp Window is the origin and is 

measured 0,0. As with the Cartesian sys-

tem, the positive X direction extends to 

the right of the origin, however the posi-

tive Y direction goes DOWN from the ori-

gin instead of up (Fig.32).  This may seem 

strange, but the reason why AE does this 

is to keep the numbers positive. Just to 

confuse us even more, Z is reversed posi-

tive for negative.

If you want to see how this relates to a 

real composition, open 07_Coordinates 

comp. I’ve added a New Solid to the center 

of a 320 x 180 comp. You will see that its 

position coordinates are not (0,0) as you 

might expect something in the center of 

the screen to be.  Rather the location will 

be (160, 90) which is half of the width and 

half of the height of the comp.  Using a 

standard Cartesian system the Y value 

would normally be negative, (160, -90), so 

by fl ipping the Y axis the numbers look 

more normal for the regular AE user. Close 

the 07_Coordinates comp when you have 

fi nished looking at it.

Cartesian 
origin (0,0)

X value

Y value

After Effects 
origin (0,0)
After Effects 
origin (0,0)

X value

Y value

X value

Y value

Figure 31: The Cartesian system: Positive X is measured from the origin 

(centre) to the right. Positive Y is measured from the origin upwards.

Figure 32: The After Effects system: Positive X is measured from the origin 

(top-left) to the right. Positive Y is measured from the origin downwards. 

The X value is reversed positive for negative.

So what does this all mean to the Invigorator?  Well, since the 

origin is offset away from the center of the screen and the Y 

axis is fl ipped, we have to compensate for this when we link 

AE’s 3D layers and Invigorator objects. The easiest way to do 

this is to use expressions to offset the values. I’ve written a 

formula for you which will work in any sized composition to 

correct the offset.
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46 First of all, make sure that you have the 05_Invigorator 

comp open.

47 Select the Logo layer and then double-hit the ‘E’ key to 

open up any expressions attached to the layer.

48 Click at the end of the Set 1 X Position expression and then 

add: -[width/2] after the expression so that it reads: 

this_comp.layer(“logo above door”).position[0]-[width/2] 

 This will subtract half the comp width from the result of the 

expressed value (-[width/2]). 

49  Click at the end of the Set 1 Y Position expression and then 

add: *-1+[height/2]  after the expression so that it reads:

this_comp.layer(“logo above door”).position[1]*-1+[height/2] 

 

 This will multiply the expressed value by -1 (*-1), which will 

make it a positive value. It will then add half of the comp 

height to the result (+[height/2]). 

50  Finally, click at the end of the Set 1 Z Position expression 

and then add: *-1 after expression so that it reads:

this_comp.layer(“logo above door”).position[2]*-1

 This will multiply the expressed value by -1 (*-1), which will 

make it a positive value.

Figure 31: Use my formula to convert Cartesian values to After Effects values

The logo should now be in 

position above the doorway 

of the nightclub. If your comp 

window does not look like the 

one in fi gure 32 please check your Timeline. 

The expressions should be exactly the same as 

in fi gure 31. If they are not then please retrace 

your steps carefully back to step 45 and follow 

the instructions again.

The logo should now be in 

position above the doorway 

of the nightclub. If your comp 

window does not look like the 

Figure 32: Your logo should look like this

If you have the Production 

Bundle of After Effects you 

can use the Glow effect to 

make it appear as if there 

is light emitting from the sign

51 Go to the Stylize menu>Glow; change 

Glow Threshold to 70; Glow Radius to 5 

and Glow Intensity to 0.5
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As well as rendering out the passes that are included in the 

Composition, Cinema 4D also renders out various Special 

Passes, including a color pass; illumination pass and a depth 

pass. These special passes can be used to further enhance your 

footage, let’s take a look at how we can use the Depth pass. 

Try looking at any panoramic scene where you can see far into 

the distance; if you look at objects close to you they appear 

sharp and defi ned; objects which are in the distance will be 

more blurry and have less detail, this is a natural phenomenon 

occurring because the lens in your eye is set to focus sharply 

on a specifi c range of depths; anything outside this range will 

gradually blur into the distance. Cameras have an even more 

restricted focus range which is known as the depth of fi eld. 

The human eye can automatically adjust its depth of fi eld but 

a cameras depth of fi eld is determined, most importantly by 

the Aperture setting and the Focal Length of the Lens. 

Adding a depth of fi eld blur to your 3D scene can really enhance 

it and make it more convincing. You can add realistic Depth 

of Field effects in post-production using the information con-

tained in the depth pass of your multi-pass render. 

1 In the Project Window, double-click the 06_depth comp to 

open up its Timeline and Composition Windows.

2 Still in the Project Window, open up the Special Passes 

folder to see its contents. Notice there are three special 

passes within it.

3 Drag the tutorial_depth.mov from the Special Passes 

folder on to the Timeline and then RAM preview the 

Composition.

Notice that this pass contains only grayscale information. The 

white areas represent areas which need to be blurred 100%; the 

black areas are where no blurring should occur; any gray areas 

will be partially blurred according to their luminance. Notice 

that the furthest surfaces from the camera will be pure white.

4 Switch off visibility for the tutorial_

depth.mov layer by clicking on its 

Video Switch in the Timeline.

5 Click on the Timeline to make 

it active and then go to Layer 

menu>New>Adjustment Layer. 

By applying our blur to an 

Adjustment Layer we can control 

which layers are to be affected by the 

blur. (For more information regarding 

Adjustment Layers see page 68 of 

Creative After Effects 5.0).

6 With the Adjustment Layer selected, go 

to Effect>Blur & Sharpen>Compound 

Blur. The Adjustment layer applies 

its effects to all layers lying beneath 

it in the Timeline. This saves us from 

having to apply the effect to each layer 

individually.

7 Depth of Field

Figure 33: The Special Passes folder
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The Compound Blur effect blurs pixels in 

the layer to which it is applied, based on 

the luminance values of a selected Blur 

layer. This Blur layer can be any layer 

within the comp, visible or otherwise.

7 In the Effect Controls Palette, choose 

the tutorial_depth.mov layer from the 

Blur Layer menu to use its luminance 

values to blur the Adjustment Layer.

8 Change Max blur to 1.5 to achieve a 

more subtle result (see Fig. 34).

9 RAM preview the comp to see the depth 

of fi eld blur applied to your movie. 

10 Move to the four-second mark and 

notice that the blur extends over the 

edge of the logo.

11 To remove the blur effect from the 

logo layer, simply drag the Adjustment 

Layer so that it sits below the Logo 

layer. Remember that Adjustment 

layers only affect layers below them in 

the Timeline.

12 Open 08_FINAL COMP if you want to 

compare your fi nal results with mine.

13 Feel free to add some new effects. In 

my fi nal movie, for example, I added 

a wiggle expression to the glow 

settings to make the sign fl icker. I also 

experimented with some other material 

and bevel settings in Invigorator to 

make the logo seen in Figure a on page 

one of this tutorial.

14 RAM preview the comp to see the 

fi nished result in real time.

Let’s now take a look at how you would use multiple passes 

if they came from another 3D program, which didn’t export, 

directly to the After Effects Timeline. In these cases the mul-

tipass composite has to be constructed manually.

Most of the mid to high-end 3D applications are capable of 

outputting multiple passes, this usually appears as an output 

option in the render settings of the application. Software 

programs that supports multi-pass rendering include; Maya; 

Lightwave and 3D Studio Max but there are several others. 

The content and naming structures of the passes will vary 

from application to application but the basic techniques are 

the same across the board.

If you are using any of the aforementioned programs to cre-

ate your passes, you will need to the go through the following 

process in order to composite your passes correctly in After 

Effects.

1 Open project named, Multipass_02.aep.

2 Select all of the QuickTime movies in the Project Window 

and drag them onto the New Comp button 

in the Project Window. This will open up the New 

Composition from Selection dialog box (See Fig.35). 

This is a new feature of After Effects 5.5; it gives you more 

control over the way that your selected layers are placed into 

new compositions.

Figure 34: Compound Blur settings

8manual 
    multipass
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3 From the Create section, choose Single composition, this 

will ask AE to make a single composition containing all of 

the fi les you have selected (Fig. 35). 

Notice that there are other options to allow you to make 

individual comps from each fi le, adjust the dimensions and 

timing of the fi les and even sequence your fi les with or without 

cross-fades.

4 Click OK to leave the dialog box and notice that all your 

layers have been placed into a brand new Timeline.

If you preview the Timeline you will notice that the layers are 

simply placed one on top of the other in the order in which 

they were selected, the top layer is obscuring all the layers 

beneath it. In order to combine the layers into their correct 

order, we will need to do a fair bit of re-ordering and a lot of 

experimentation with our blending modes, let’s have a go!

5 First of all, select the Tutorial_light1.mov layer and drag 

it to the top of the Timeline, so that it obscures all other 

layers. 

Notice that this light is a spotlight, it is a directional light, and 

the light from it only falls on surfaces that lie within the direc-

tion and cone angle of the light. The white areas represent 

surfaces that are affected by the light; any black areas are 

not affected.

In order to re-composite our multi-pass layers back together 

again we can use the After Effects blending modes.

6 Make sure that the modes panel is 

visible. If not, context-click on the 

Switches panel heading and choose 

Panels>Modes from the context-

sensitive menu.

7 For the Tutorial_light1.mov layer, 

choose the Add mode from the Blending 

Mode menu. Notice how the add mode 

combines the two layers together by 

adding the top layers numeric color 

value to the bottom layers numeric 

color value and displaying the resulting 

color value.

8 OK, in the Switches column, click on 

the Solo button for layer number 

7, tutorial_light4.mov, notice 

that this light is an ambient light. In 

other words, it is an evenly distributed 

light with no direction, it affects all of 

the surfaces in the scene, unlike the 

spotlight which was directional light, 

only affecting certain areas within it’s 

cone angle.

9 Switch the solo button off again 

and then drag the layer underneath 

tutorial_light1.mov

10 Change its mode also to Add mode. 

It, too now combines with the layer 

directly beneath it (Fig. 36).

Figure 35: The Composition from Selection box

Figure 36: Using Blending Modes to combine layers
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Notice how the layers are combining with 

each other to create a seemingly complete 

environment, let’s expand on this.

11 Select all the remaining tutorial_light 

layers and drag them so that they 

lie directly beneath the tutorial_

light4.mov.

12 With all the layers still selected 

choose Add mode from any of the 

layers Blending mode menus to 

change the modes of all selected layers 

simultaneously.

You should now have all of the lights on in 

your composition lighting up your scene 

quite nicely. Let’s now add a bit more 

detail to the scene by combining some of 

the other passes.

13 Drag the tutorial_atmos.mov movie to the 

top of the Timeline and switch it’s mode 

to Add. This will add realistic highlights 

to the spotlights and some light rays 

which emit from the fl oor lights.

14 Repeat the last step, bringing the 

tutorial_ambient.mov to the top and 

changing it’s mode to Add.

15 Repeat again, this time with the 

tutorial_refl .mov. This pass adds some 

lovely refl ection to the scene adding a 

touch of realism.

16 Finally, drag the tutorial_shadow.mov 

layer so that it lies just above the 

tutorial_diffuse.mov and switch it’s 

mode to Multiply. This will combine 

all the shadowy areas to the scene.

OK, so eventually we have our scene looking just as it did in 

Cinema 4D (Fig. 37). It took us quite a bit of time to get the 

layers in the correct places, without this tutorial to guide you 

it would have taken a fair bit of trial and error before getting 

the layer order and modes correct but you can see that the 

technique works. Try outputting some multipass fi les from 

your own 3D application of choice, then experiment with the 

techniques used in this tutorial. Happy Keyframing! 

Main Maxon site

http://www.maxon.de

Download link for the AE5.x import plugin

http://www.maxon.de/pages/download/download_updates_

e.html

Makers of SLA

http://www.bhodinut.com

Cinema4D & AE forum

http://www.postforum.com

Cinema4D & AE forum

http://www.creativecow.com

Watch this space for forthcoming tutorials on working with 

RPF fi les from Maya; Smart Mask Interpolation; Character 

animation and more!

You can fi nd out more about Blend-

ing Modes in the Technical.PDF 

which is included on the Creative 

After Effects 5.0 CD ROM.

Figure 37: The fi nished composite


